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Creating Accessible Content 
Documents 
This section discusses how to use heading styles; add alt text or captions to images; and use 
descriptive text for links.  
 

Text: Heading Styles  
Headings are necessary for organizing and formatting your document. With properly styled 
headings, an individual can easily scan and follow your document and a hierarchy is created and 
followed for a screen reader. Headers are also beneficial for manuscripts and creating a table of 
content. Let’s use levels 1 – 3 headers for APA formatting as an example.  

• Level 1 headers: Centered, Boldface, Title Case 

• Level 2 headers: Flush Left, Boldface, Title Case Heading 

• Level 3 headers: Flush Left, Boldface Italics, Title Case Heading 

In the above example, if you do not use a heading style in Word, you will have to remember the 
formatting for each level and apply it correctly. By using a heading style, you decrease errors 
and ensure you are consistent with formatting throughout the document. The same applies for 
accessibility. By using a heading style, you ensure your document is accessible to everyone, 
especially individuals using assistive devices such as screen readers.  
 

1. Open Microsoft Word. 
2. Format the text as you would want it to appear – ex. center, bold, title case, etc.  
3. To create a style, select the formatted text.  
4. On the Home menu, navigate to the Styles section. 

Note: You will see all the styles that are currently available in the document. You will 
have to create a new style for each header you are adding.  

5. Click Styles Pane. 

6. Click New Style. 
7. Type a name for the style. 
8. Verify the formatting is correct based on your formatted text.  
9. Click OK.  

 

Text: Hyperlink Text - Documents   
In some cases, you may have to provide a URL in a document, Canvas course, in email, etc. If so, 
best practice is to link the URL and provide descriptive text as some individuals with visual or 
other impairments may use screen readers to view the link. With a screen reader, clear and 

Step 5 

https://forms.monday.com/forms/5aa05b812dd4eeb61e5cdd093b95f859?r=use1


 
 

Inspiring Innovation and Excellence in Education 
Contact EDT by submitting a request 

2 

Instructional Resource 
Educational Design & Technology (EDT) 

USF College of Nursing 

©Copyright 

 

accurate descriptive text allow individuals to easily skim through a document or a website and 
navigate to the link.  
 

• Bad Example: Click here to learn more. OR Click this link to learn more. 

• Good Example: Visit USF website to learn more.  
 

Images: Alt-Text - Documents 
Alt text is short for alternative text. It is a short text description of an image or other media 
type. Individuals who use screen readers are benefited as the reader will read the alt-text. 
Every image in a course, document, PowerPoint, etc., must have alt-text. WebAim recommends 
if the image does not convey relevant or important content, empty alt text of “” would suffice. 
These topics are discussed in this section.  
 
To add alt-text to an image: 

1. Insert the image into your Word document. 
2. Select the image and the Picture Format tab will appear. 
3. Click Alt Text.  
4. Enter a brief description about the image. 
5. If the image has not relevant or important content, check Mark as decorative.  

Note: Images marked as decorative will be read as such so that individuals who using a 
screen reader will know they aren’t missing important information.  

Images: Captions 
There may be times where you need to add a caption to an image rather than alt-text. Captions 
are ideal when connecting images to text (such as a figure or chart).  
 
To add alt-text to an image: 

1. Insert the image into your Word document. 
2. Select the image. 
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3. Click the References tab. 
4. Click Insert Caption. 

5. Type a name in the Caption field. 
6. Click OK.  

 

Images: Long Descriptions 
If the description of your image is beyond the recommended 1-2 sentences for alt-text and a 
caption, consider using a long description. The long description is included in the text of the 
document where you describe and explain the image in depth.   
 

Presentations 
This section discusses how to add alt text to images, use descriptive text for links, and set the 
reading order of slide content.  
 

Images: Alt-Text - Presentations 
Alt text is short for alternative text. It is a short text description of an image or other media 
type. Please read the full description above on alt-text for documents.  
 

1. Navigate to the slide with the 
image.  

2. Right-click on the image. 
3. Click Edit Alt Text.  
4. Type a brief description of the 

image in the text field.  
 
Note: If a brief description of 
the image is not sufficient, 
consider collaborating with 
EDT to recreate the image or 
finding a different image.  

 

 

Text: Hyperlink Text - Presentations 
When linking text in a presentation, ensure the text is descriptive, clear, and accurate. Keep in 
mind that some individuals may use screen readers and the readers will scan the slide for links. 
Review the Hyperlink Text section above under documents for examples.   
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To insert a hyperlink on a slide: 
1. Select the text.   
2. Click Insert. 
3. Click Hyperlink.  
4. Verify the Web Page or File tab is selected.  
5. Paste the URL in the Address field. 
6. Click OK.  

Note: You can do the same thing for 
linking to other slides or adding email 
addresses on the slide. Just click the 
corresponding tab in step 4.  

 
Set the Reading Order 
Screen readers will read the contents of the slide in the order they were added to the slide.  
After you have designed each slide, check the reading order of the content on the slide for 
screen reader capabilities. This will ensure the content is read in the order you intend.  
 

1. Open your PowerPoint presentation. 
2. Click the Review tab. 
3. Click Check Accessibility. 

Note: An Inspection Results window will 
appear on the right with a report.  

4. Navigate to the Warnings section and click the 
down arrow next to Check reading order. 

Note: A list of slides where the reading order need to 
be checked will be listed.  

5. Navigate to the slide where the reading order needs to be corrected.  
6. Once on the slide, click Selection Pane. 

a. If you do not see Selection Pane, click the Accessibility tab and select it. OR 
b. If you do not see Selection Pane, click the Home tab, click the down arrow next 

to Arrange, and select Selection Pane.  

Note: The Selection Pane will show the reading order in reverse - bottom to top.  

7. Click an item to see which one is which. 
8. Click and drag to items to the correct position to change the reading order. Keeping in 

mind that the correct order will be listed bottom to top.  

 

PDFs 
If you have PDFs that are not accessible (e.g., scanned PDF), you can make them accessible 
using Adobe Acrobat Pro. This software is available to all USF faculty and staff on USF IT 
website.  
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Access USF IT website to download Adobe Acrobat Pro. If you experience problems or receive a 
warning, contact USF IT and they will guide you through the process.  
 

Check Accessibility of PDFs 
If you are unsure if your document is accessible or not, you can use Adobe Acrobat Pro to check 
the accessibility of documents.  
 

1. Access Adobe Acrobat Pro and open the document that is not accessible. 
2. Click Tools in the top left corner. 
3. Scroll down to the Protect & Standardize section and click Accessibility. 

 
 
 
 
 
 
 
 
 
  

4. Click Accessibility Check from the right-hand menu.  
5. Click Start Checking. 
6. View the report that appears in the Accessibility Checker window on the left or the 

report saved in your Documents folder. 

 

Make PDFs Accessible 
1. Access Adobe Acrobat Pro and open the document that is not accessible. 
2. Click Tools in the top left corner. 
3. Scroll down to the Customize section and click Action Wizard.  
4. Click Make Accessible from the right-hand menu. 

5. Click Start. 
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a. If the document is not opened, you will want to click Add Files to add the 
document that is not accessible.  

6. Follow the onscreen prompts to make the document accessible.  
a. In the Document Description window, you can type a description or choose 

Leave as is. 
b. In the Set Alternate Text window, the pieces of the document that are detected 

as images will be displayed. You can type alt-text or checked Decorative figure.  
c. Click Start Checking. 
d. A report will be provided if you left that option checked in the Start Checking 

window. View the report that appears in the Accessibility Checker window on 
the left or the report saved in your Documents folder. 

 

Videos  
If you have videos that do not have closed captioning or a transcript, you can use Kaltura to 
generate a script. Please note just because a video is on YouTube, does not mean it is 
captioned. Follow the instructions below to generate a transcript for your videos.  
 

1. Access your Canvas course.  

Note: If you have a demo course, you can perform these steps in that course as you’re 
just generating a script. 

2. Click My Kaltura from the course navigation menu.  

Note:  If you do not see Kaltura in the menu, click Settings and select the Navigation 
tab. Then move Kaltura up to top menu.  

3. Click Add New. 

 
4. If you have a mp4 saved to your computer, click Media Upload.  
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a. Click Choose a file to upload. 
b. Navigate to the saved video and upload it.  
c. Verify the file name. 
d. Scroll down and click Save.  
e. The script will take some time to generate.  

5. If it is a YouTube video, click YouTube. 
a. Paste the YouTube video URL into the text box.  
b. Click Preview. 
c. Verify the file name. 
d. Scroll down and click Save.  
e. The script will take some time to generate.  

6. After some time has passed, you can check to see if the script has finished generating by 
clicking My Kaltura. 

7. Click the name of the video. 
8. Click the download icon immediately below the video and to the left of Show transcript.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: If you do not see the download icon, it could mean the transcript is still processing 
or there may be an error with processing the script. To check for processing: 

a. Click Actions. 
b. Select Caption & Enrich.  
c. In the Status column, you will see if the video is still processing, an error 

message, or completed.  
9. Once you have downloaded the transcript, check it for accuracy and make corrections as 

needed. 
10. Access the course and module page that has the video and linked the transcript next to 

the video.   
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Canvas 
Canvas has some built in accessibility features that you can use to ensure the accessibility of 
your content.  
 

Images: Alt-text - Canvas 
1. Add the image to the Canvas page. 
2. Click the image. 
3. Click Image Options.  

  
 
 
 
 
 
 
 
 
 
 
 
 

4. In the Image Options window, type alt-text in the text field. 
a. If the image is decorative, check Decorative Image.  

5. Click Done. 
6. Click Save.   

 

Canvas Accessibility Checker 
There is an accessibility checker option in the Rich Content Editor. This checker detects 
common accessibility issues for items on the page.  
 

1. Access a Canvas page (e.g., module, discussion, assignment, etc.). 
2. Click Edit. 
3. Click the Accessibility Checker icon (bottom right next to word count).  

Note: A window will appear on the right with the issues.  
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4. Review the report for each issue and select the appropriate action to take from the 
drop-down menu. 

5. Click Apply. 
6. Click Next to view other issues.  
7. Repeat the prior steps to view and fix all accessibility issues.  

 

WebAim Contrast Checker 
With the WebAim contrast checker tool, you can check the contrast between the background 
color and text color.  
 

1. Access the WebAim Contrast Checker website.  
2. Enter the hex value for the font color in the foreground color field. OR  Click the color 

shade next to the textbox and select the color from the wheel.  
3. Enter the hex value for the background color in the background color field. OR  Click the 

color shade next to the textbox and select the color from the wheel. 
 
 
 
 
 
 
 
 

4. Press the Enter/Return key on your keyboard. 
5. You will want to see a Pass for the WCAG AA at minimum. If you don’t receive a Pass, 

adjust your colors.  
a. WCAG stands for Web Content Accessibility Guidelines. These guidelines have 

three levels of conformance. AA is in level two and have criteria to meet to 
satisfy this guideline.   
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